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Major Key points …what students need to know 
 
Role of Academic Support 
Academic Support Coordinators (ASC’s) are dedicated to student support and are equipped to handle most student 

concerns. Your ASC’s should be your first point of contact for most questions and concerns. The toll free Academic 

Support line is staffed from 8:00 AM – 12:00 AM Monday through Friday, 8:00AM – 4:00 PM on Saturday, and 

3:00 PM – Midnight on Sunday Eastern Time. 

 

 
1. Questa navigation 
2. Attendance 
3. Computer settings 
4. Virtual Library 
5. Student Portal 
6. Financial Aid 
7. Registrar Information 
8. Microsoft Assistance 
9. Internet Explorer 7 

These are the major things to cover, with details. 
 
 
IMPORTANT LINKS  

Course Website: http://www.distance-education.itt-tech.edu  

Virtual Library http://library.itt-tech.edu/default1.asp 

Course Catalog and Student Calendar http://www.itt-tech.edu/campus/download/011.pdf 

Student Portal   http://studentportal.itt-tech.edu 

ITT-Email  www.hotmail.com 

 

Whom to contact with questions or concerns? 
 

ACADEMIC SUPPORT COORDINATORS (1-877-456-7134)  

• Orientation information 

• Virtual Library information 

• Course related information 

• Instructor related information 

• Attendance related information 

• Login and password problems 

• Course Management System Navigation 

• Course Management System software bugs, etc 

• Help on browser Plug-in needed to access and view 

• Content launch issues (accepting cookies, browser 



• Address change information 

 

security settings, etc.) 

 

 

ADMINISTRATIVE SUPPORT  

Jakeisha Cozmanoff  1-877-456-7134, x 5222) 

 

• Academic advising appointments 

• Contacting your School Chair 

• Contacting Associate Deans 

• Contacting the Dean 

• Contacting the Director of Online Programs 

 

REGISTRAR (1-877-456-7134) 

David Bolander (dbolander@itt-tech.edu) 

Claire Somerville (clsomerville@itt-tech.edu) 

• Test-out application 

• Grade reports 

• Transcript requests 

 

 

FINANCIAL AID REPRESENTATIVES 

Please dial 1-888-488-0007 and request to speak to a Financial Aid Administrator 

 

 

How to Access to ITT-Online Systems. 
 

Login Information: 

 

 http://library.itt-tech.edu/default1.asp This link is to access the Virtual Library also located on the Course 

Dashboard. This requires you to set up an account by clicking on New Students click here to register. School 

Location: Indianapolis (Online),  

                                                                          

         

                                                                                   

www.distance-education.itt-tech.edu   This link is the Gateway to your education. You will use this link 

access for classes and course materials.                    User ID: Student ID/Pin  

                                                                                   EX:   01234567 

                                                                             Password: password   this is the initial password until you have 

logged into Questa, then you are required to change the password. 



                   Access to the course dashboard.                                           

http://studentportal.itt-tech.edu This link allows access to the Student Portal. Here you can access each of the 
links above as well as Career Services, Instructor Evaluation Surveys information.  
To access this site use:   User ID: ex.01234567 Password: Date of Birth:  10101985 MMDDYYYY 

 
 
Required Downloads 
www.Java.com   
 

 Offline installation, typical setup. 

www.Adobe.com   Flash player and Reader Solutions and products 

Download Adobe Reader, Flash Player and Shockwave Player 

 

 

Get Shockwave Player  
 
If you are unable to access, the links successfully please contact Academic Support 1-877-456-7134. 
 

Tutor Information:Tutor Information:Tutor Information:Tutor Information:    
    
Linda Bond        (Ext. 5405)    9am- 6pm         Sun-Thurs       TB184 Problem Solving and GE127 College Mathematics 

 
Donna Brubeck (Ext. 5407)    8am - 5pm        Mon-Fri           Writing, Composition, and Criminal Justice 
 
Sherron French (Ext. 5281)    5pm – 10pm     Sun-Thurs        Math I, Math II, and TB184 (if needed) 
 
Patricia James   (Ext. 5280)    5pm – 10pm     Sun – Thurs     Accounting I and Accounting II 



 

 
 
 
 
 
 
QUESTA TIPS AND SETTINGS 
 

Vista/McAfee slowness issue… 
 

1) From the start menu, select “Run”. Type the following: 
 

services.msc 
 

This will bring up a list of applications running on the system. Scroll down and find 
McAfee, then double-click on “McAfee Redirect”, then click on “Stop Service” 

 
2) In internet options, under the security tab (with Vista, IE 7), at the bottom of the 

window, there is an option that says, “Enable Protected Mode”. You will want to 
make sure this box is unchecked. 

 

Internet Explorer Integrated Pop-Up Blocking 

With the release of Microsoft’s XP Service Pack 2, Pop-Up Blocking is now directly integrated into 
Internet Explorer (versions 6 and 7).  By default, Pop-Up blocking is Enabled. 



 
  

To disable click the Pop-up Blocked information bar at the top of your browser window. Then click 
Always Allow Pop-ups from This Site in the drop-down.  Next, click the RETEST button on the Pop-Up 
Blocker Detected Page.  If the "Welcome" screen appears, you have disabled all Pop-Up Blockers.  If the 
"Pop-Up Blocker Detected!" page reappears, then you have more Pop-Up Blockers to identify and 
disable. 

 

Common Toolbar Pop-Up Blockers 

Listed below is some of the more popular Pop-up Blocking software Packages that run in Internet 
Explorer and the workarounds in order to disable them to use the ELC.   In general, most Pop-Up 
Blockers will install themselves either within the browser toolbar, or within the Windows Taskbar along 
the bottom right corner.  Instructions with screenshots on how to disable  Yahoo, Google, MSN, AOL, 
Viewpoint,  AIM, & PopUpCop Toolbars, and Pop-Up Stopper are listed below.   

To find out if you have Toolbar Pop-Up Blockers like  Yahoo, Google, MSN, AOL, Viewpoint,  AIM, & 
PopUpCop you can look at the area between the Address Bar (where you type a web address or URL) 
and the web page content.  In the screenshot below you can identify Google, Norton Internet Security, 
and, Yahoo (Y!) Toolbars. 



Sometimes Toolbars can be hidden from your view, but still block Pop-ups.  To see all of the Toolbars 
available in Internet Explorer 6 and click View>Toolbars.  In the left screenshot below, you can see that 
Google, Norton Internet Security, and Yahoo Toolbars are installed but are unchecked and hidden to 
users.  To see all of the Toolbars available in Internet Explorer 7 and Tools>Toolbars.  In the right 
screenshot below, you can see that the Google toolbar is installed, checked, and visible to users.   

Internet Explorer 6 Toolbars Internet Explorer 7 Toolbars 



  

In order to disable their popup blocking functionality you will first need to click on and check each 
unchecked Toolbar in the Toolbars Menu.  When you are finished, you are View>Toolbars Menu will 
look similar to the screenshot below. 



Once you are able to view all of your browser's toolbars, you can begin disabling Pop-up Blocking.  
Matching up your Toolbars with the screenshots below and follow the instructions for disabling. 

Yahoo Toolbar  

Probably the most popular toolbar, this program allows several other functions besides Pop-Up Blocking. 
Listed below is how the bar will appear within IE: 

The following icon is the Pop-Up Blocker: 

 



To disable Pop-Up Blocking, Click on the Down arrow to bring up the Menu: 

 

Uncheck the entry Enable Pop-Up Blocker. Next, click the RETEST button on the Pop-Up Blocker 
Detected Page.  If the "Welcome" screen appears, you have disabled all Pop-Up Blockers.  If the "Pop-
Up Blocker Detected!" page reappears, then you have more Pop-Up Blockers to identify and disable.  
Once you have logged out of the ELC, you can go back in and recheck the entry to re-enable your Pop-
Up Blocker. 

  

Google Toolbar  

Google has their own brand of toolbar that is very similar to Yahoo’s. It offers other features on top of 
Pop-Up blocking, and looks like the following:  

The following icon is the Pop-Up Blocker:  

 

Clicking on the icon so that it changes to reflect that Pop-Ups are allowed will allow the user to use Chat 
and Instant Messaging in the ELC 

 

  

MSN Toolbar 



MSN Toolbar is the latest of the toolbars, but is starting to gain popularity. As with Yahoo and Google 
Toolbars, it allows other features on top of Pop-Up Blocking.  Below is the MSN Toolbar: 

The following icon is the Pop-Up Blocker:  

 

To disable Pop-Up Blocking, Click on the Down arrow to the right of the text to bring up the Menu:  

-  

Click on Allow Pop-ups. Next, click the RETEST button on the Pop-Up Blocker Detected Page.  If the 
"Welcome" screen appears, you have disabled all Pop-Up Blockers.  If the "Pop-Up Blocker Detected!" 
page reappears, then you have more Pop-Up Blockers to identify and disable.   Once you have logged 
out of the ELC, you can go back in and recheck the entry to re-enable your Pop-Up Blocker. 

  

AOL Toolbar  

AOL Toolbar is another fairly new toolbar from one of the big Online Providers. Like the others, this 
Toolbar offers multiple features, and appears in the browser as follows:  

The following icon is the Pop-Up Blocker: 

 

To allow Pop-ups to appear, merely click on the icon. You should now see the following:  

 

Next, click the RETEST button on the Pop-Up Blocker Detected Page.  If the "Welcome" screen appears, 
you have disabled all Pop-Up Blockers.  If the "Pop-Up Blocker Detected!" page reappears, then you 
have more Pop-Up Blockers to identify and disable.  Once you have logged out of the ELC, you can click 
the icon again to re-enable your Pop-Up Blocker. 

  



Viewpoint Toolbar 

Viewpoint Toolbar is often inadvertently installed along with Viewpoint Player, media player software.  
This Toolbar provides search functionality and shows snapshots of search results' pages.   

Clicking on the word Viewpoint on the right end of the Toolbar will open the drop-down list shown below. 

  

Clicking on the Options Menu in the drop-down list will open the "Viewpoint Toolbar Options" shown 
below.  To disable Pop-up Blocking choose the Pop-ups Tab and uncheck the Enable Pop-up 
Blocker box.  Then click the OK button.   

 

Next, click the RETEST button on the Pop-Up Blocker Detected Page.  If the "Welcome" screen appears, 
you have disabled all Pop-Up Blockers.  If the "Pop-Up Blocker Detected!" page reappears, then you 
have more Pop-Up Blockers to identify and disable.  Once you have logged out of the ELC, you can go 
back in and recheck the entry to re-enable your Pop-Up Blocker. 

  

AIM Toolbar 



AIM Toolbar is often inadvertently installed along with AOL Instant Messenger, instant messaging 
software.  This Toolbar provides search functionality and interacts with AOL Instant Messenger.   

Clicking on the AIM button on the left end of the Toolbar will open the drop-down list shown below. 

 

Clicking on the Toolbar Options in the drop-down list will open the "AIM Toolbar Options" shown below.  
To disable Pop-up Blocking choose the Popup Blocker Tab and uncheck the Block Popup Windows 
box.  Then click the OK button.   

 

Next, click the RETEST button on the Pop-Up Blocker Detected Page.  If the "Welcome" screen appears, 
you have disabled all Pop-Up Blockers.  If the "Pop-Up Blocker Detected!" page reappears, then you 



have more Pop-Up Blockers to identify and disable.  Once you have logged out of the ELC, you can go 
back in and recheck the entry to re-enable your Pop-Up Blocker. 

  

PopUpCop 

Another popular Pop-Up Blocker, this software is also designed solely for preventing Pop-Ups. It installs 
the following toolbar within the browser:  

To disable Pop-Up Blocking, click on the arrow to the right of the badge and a menu will appear with a 
list of options: 

 

Click on Disable PopUpCop. Next, click the RETEST button on the Pop-Up Blocker Detected Page.  If 
the "Welcome" screen appears, you have disabled all Pop-Up Blockers.  If the "Pop-Up Blocker 



Detected!" page reappears, then you have more Pop-Up Blockers to identify and disable.  Once you 
have logged out of the ELC, you can go back in and recheck the entry to re-enable your Pop-Up Blocker. 

  

Pop-Up Stopper  

One of the more popular Pop-Up Blockers available, this software is designed solely for preventing Pop-
Ups. It will install an icon in the lower right corner of your Start Menu Toolbar 

The following icon is the Pop-Up Blocker:  

 

 
To disable Pop-Up Blocking, right-click on the icon and a Pop-Up menu will appear with a list of options:  

 

Uncheck the option Block pop-up ad windows. Next, click the RETEST button on the Pop-Up Blocker 
Detected Page.  If the "Welcome" screen appears, you have disabled all Pop-Up Blockers.  If the "Pop-
Up Blocker Detected!" page reappears, then you have more Pop-Up Blockers to identify and disable.  



Once you have logged out of the ELC, you can go back in and recheck the entry to re-enable your Pop-
Up Blocker. 
 

 Internet Explorer 7 computer settings 

 
 
Click on Tools tab, go to Pop up Blocker, and then click on pop up blocker settings. 
 

 
 
Type www.distance.education.itt-tech.edu in Address of website to allow. 

 

 
 

 This allows pop 
up windows to 
appear. 

Click tools upper right 
hand corner, pop up 
blocker and then pop up 
blocker settings 



 
 
 
 

Delete cookies and Temporary Internet files to ensure available disk space to support Online program. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 From tools tab, click here to 
access tabs for deleting 
cookies and temporary files. 

 Click here, delete files, and 
delete cookies. This will free 
disk space. 



 

 

 

 

 

 

Microsoft Assistance 

 

 

Excel Worksheet Basics  

• Basic terminology 
• Entering and Editing Data 
• Using automatic features 
• Using Functions 
• Using Equations 
• Calculating Percent and Using Absolute Cell 

Reference 

Excel Worksheet Basics Excel X for Macintosh 

• Basic terminology 
• Entering and Editing Data 
• Using automatic features 
• Using Functions 
• Using Equations 
• Calculating Percent and Using Absolute Cell Reference 

• Standard Toolbar  
• Formatting Toolbar  
• Drawing Toolbar  
• Customizing Toolbars  
• Using menu items part 1 (File, Edit, and View menus) 

PC  
• Using menu items part 1 (File, Edit, and View menus) 

Creating and Designing Single Use Spreadsheets 

• Calculating sales tax on a purchase  
• Calculating the cost of a trip by car  
• temperature converter  
• calculate the price of pizza per square inch  

 Click yes to complete, 
deleting files, and deleting 
cookies.  



Macintosh  
• Using menu items part 2 ( Insert, Format, and Tools 

menus ) PC  
• Using menu items part 2 ( Insert, Format, and Tools 

menus ) Macintosh  
• Using Keyboard Shortcuts in Microsoft Excel 

PC/Windows version  
• Using Keyboard Shortcuts in Microsoft Excel 

Macintosh version  

Internet4Classrooms forms and templates in .xls 

format  

• Graph paper - Excel files with small, medium, and large 

grids.  
• Pre-Reading Clock - establishing vocabulary readiness  

• Quadrille paper - Excel files with small, medium and 

large grids, every fifth line is darker  
• Venn Diagram - two circle, three circle, and instructions 

to make your own  

• Using Microsoft Excel to perform classroom tasks  • Analyzing Classroom Data - a simple survey 

Advanced Topics  

• Using Excel to Create a Chart or Graph  
• Using Excel as a grade book  
• Using Mail Merge  
• Using Mail Merge - Office 2002  
• Fostering Literacy with Excel  
• Recording a simple macro  
• Create a chart using pictures for the bars or columns  
• Create an interactive crossword puzzle  
• Create a concept map using Excel  
• Use an Excel worksheet to create a matching activity  
• Make a Scatter Plot with Excel  

• Using PowerPoint to animate an Excel Chart: Office 

2002, Office 2000, or Macintosh X  
• Using a Radar chart to analyze data  
• Make a Custom List  
• Use Excel to Import Data from the Internet  
• Using Conditional Formatting  
• Use Excel to Write a Branching Story  
• Writing Mad-Libs with Excel  
• Make a Review Quiz using Drop-down menus and 

Conditional Formatting  
• Modifying Excel Charts  

Using Excel to Make Graphic Organizers  

• Make a Number 

Line  

• Make Time Line  

• Make a Venn Diagram  

• Make a Web  

• Make a Coordinate 

Plane  

• Make a Hundreds 

chart  

• Make a Ten Frame  

Sample Graphic Organizers  

• Number Line  
• Time Line  

• Coordinate plane - 4 

Quadrants  
• Template for making 

Webs  

• Ten Frame  
• Hundreds Chart  

• Moon Phase Worksheet  

• Moon Phases - Drag to 

Position  

• Record the Daily 

Weather  

Sample Workbooks to Download  

• Fahrenheit to Celsius temperature 

converter  
• M & M Spreadsheet  
• Pizza Calculator - calculate the 

price per square inch  

• Using Protection  
• Using a Macro to Clear Student 

Responses in a Quiz  
• Mad-Libs with Excel  
• Jeopardy Template See a web page 

• Sign In Sheet  
• Physics Crossword Puzzle  
• Nursery Rhyme Crossword 

Puzzle  
• Four Square Puzzle puzzles 



• Trip Calculator - How much will a 

car trip cost?  
• Fostering Literacy Using Excel  
• What would I weigh on...?  
• Twenty Four Hours of 

Temperature Data  

about this template.  
• Earthquake Project (8.4 mB)  
• Drop Down  

as a template.  
• Sample concept maps  
• How do I spend my time?  

Workbooks designed by others, shared with permission  

• Review Bingo - This workbook was written by Robert Griffith, an Oak Ridge, TN teacher. Teachers enter short answers in 

30 blocks and print 32 bingo cards (4 to a sheet on 8 sheets). Distribute the bingo cards to your class and begin the review. 

Thanks Robert! Caution: Because of the way that Excel handles dates, you must enclose any 

dates used in the bingo game in quotation marks! posted on 3/13/06  

  

The links below are not i4c modules, but they are great sources of information  

Links verified 3/12/06  

1. Almost Everything You Need for Using Spreadsheets in the Classroom - Excel Basic quizzes online 

along with illustrations of various uses of a spreadsheet for the classroom. Great links to find other 

Excel information on the Internet.  

2. Better Excel Solutions - This web site contains everything you need to know about Microsoft Excel. 

Their stated hope is that their web site helps you to get the most from your Microsoft Office 

applications.  

3. Classrooms that Excel Resources - Guides, Tutorials, Applications and Lesson Plans  

4. DataPig Technologies Excel Training - Flash movies that guide you through many lessons on 

specific Excel how to topics  

5. Excel In the Classroom: What's the hype? - a tutorial from Teach-Nology  

6. Excel Internet Library - quite a few how-to modules, from basics to advanced  

7. Excel Training - handouts and video lessons  

8. Excel Used in Classroom Activities - Numerous activities listed with examples on usage of Excel in 

the classroom.  

9. Excel-lent Middle School Math Lessons! Can a computer program motivate math students weary of 

"drill and kill"? Teachers all over the country use Microsoft Excel in ways that excite students about 

the power of math in everyday life. (a good article from Education World)  

10. The Excelets Page - Excelets are Applets made with Excel instead of Java  

11. To Excel in the Classroom is Elementary - an excellent resource produced by Kathy Adkins, 

Instructional Technology Specialist for Forsyth County Schools, GA  

12. Graphing Ideas for the Classroom - topics to use collecting information to make a graph  

13. Import Data with Excel - several suggested sources  

1. Comparing average monthly temperature maximums - use two or three locations to create a 

radar chart.  

2. The most common chemical elements in the earth’s crust - this would make a nice pie chart  

3. Population Density - persons per square kilometer - suggestion: make a bar chart or column 

chart  



4. Weather Underground - Weather Underground has an avalanche of raw data. Go to any city 

and scroll down to the History and Almanac section. In the Detailed History and Climate 

section select a date. Very complete data is available as far back as 1996.  

5. World Population Clock - projection by the U.S. Bureau of the Census  

14. Integrating Spreadsheets in the Classroom - ideas and lists of links  

15. Interactive Excel - from the Interactive Excel Project at Northwestern University's Collaboratory 

[many files to download]  

16. Jeopardy - Another example of using Excel to make a Jeopardy review game - (author unknown)  

17. Keyboard shortcuts to use with MS Excel - posted by Pearson Software Consulting Services  

18. Microsoft Excel: Tips and Tutorials using spreadsheets - Don't let the name fool you. There is 

nothing stupid about these Excel tutorials from MIStupid.com  

19. North Canton City Schools Excel Activities - Collection of activities to download and use in your 

classroom.  

20. Office Tips for Teachers from Microsoft  

1. Create a Timeline in Microsoft Excel  

2. Download a sample Timeline and Crossword puzzle clues by Nancy Slonneger, Technology 

Integration Specialist  

21. Spreadsheet Resources - standards, lessons, and resources  

22. Using MS Excel in the Classroom - Fusion: Educators Integrating Technology  

23. Using Spreadsheets as an integrated part of a Literature lesson. - Here is an example of how 

spreadsheets enter into everyday literature lessons. This lesson uses Shel Silverstein's poem Hungry 

Mungry.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Student Calendar 

  2007 2008* 2009* 

Classes Resume After 
Winter Break 

January 2 January 7 January 5 

Presidents' Day** February 19 February 18 February 16 

Winter Quarter Ends March 4 March 9 March 8 

Spring Break** March 5-11 ------------- March 9-15 

Spring Quarter Begins March 12 March 10 March 16 

Memorial Day** May 28 May 26 May 25 

Spring Quarter Ends June 3 June 8 June 7 

Summer Break** June 4-10 June 9-15 June 8-14 

Summer Quarter 
Begins 

June 11 June 16 June 15 

Independence Day** July 4 July 4 July 3-4 

Summer Quarter Ends  September 2 September 7 September 6 

Fall Break** September 3-9 --- --- 

Labor Day**  September 3 September 1 September 7 

Fall Quarter Begins September 10 September 8 September 7 

Thanksgiving**  November 22-23 November 27-28 November 26-27 

Fall Quarter Ends December 2 November 30 November 29 

Winter Quarter Begins December 3 December 1 November 30 

Winter Break**  December 24, 2007 - 
January 6, 2008 

December 22, 2008 - 
January 4, 2009 

December 21, 
2009 - January 
3, 2010 

*Tentative Dates **No classes  

 

 
 
 
 
 
 
 
 
 
 
 
 
 


